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INTRODUCTION

Overview

Welcome to the Typing Tutor IV keyboard instruction
program !  Many new features have been added to th is
product to make it  the best keyboard instruction soft-
ware on the market. Even if you have never used a

keyboard before, this program will have you typing with
ease and confidence in a very short time. Special keypad

instruction is avai lable for anyone who uses a numeric
keypad.

THE SPEED BUILDERS-TRM™ and NLG™

To be a  cons istent ly  fast  typ ist ,  you need to  be  so  fami l ia r

with the keyboard that you type by automatic response,
without consciously having to remember the location
of each key. Like its predecessor,  Typing Tutor I I I ,  the

Typing Tutor IV program uses art i f ic ial  intel l igence to

monitor your responses and custom design lessons and
tests to match your proficiency level. Using a technique

cal led Time Response Monitor ing™,  or  TRM, the pro-

gram notes the time it takes you to type each letter, then
uses this information to create each new lesson for you.

The Typing Tutor IV program not only determines

which keys you need to practice for your exact level, but
also simulates real-life typing experiences with its
Natural Language Generator™, or NLG. For truly fast
typing, it isn't enough just to learn the locations of the
keys. It's important to become familiar with key se-
quences that are commonly used in everyday language.

That is why all lessons and tests are created using actual
words, phrases, and sentences that contain the keys you 7



need to practice. Lessons are continuously adjusted to

8 a create a pace that is  chal lenging,  but not overwhelming.

And, as with real word processors, you can even back-
space to correct  mistakes.

In addition to offering extra practice on slower keys,
the Typing Tutor IV program is designed to help you
learn correct fingering. As each new key is introduced,

you  are  shown wh ich  f inger  to  use  and  are  g iven  spec ia l

drills that help you to remember that key's location in
relation to the "home row." Each "home row" finger has

a specif ic "terr i tory" to cover.  By revis it ing the program's

F inger ing  sec t ion  and  re fer r ing  to  the  keyboard  d iagram

in this manual, you wil l  quickly learn the location and
cor rect  f inger ing for  every  key on the  keyboard.

GOALS AND FEEDBACK

The monitoring techniques built into Typing Tutor IV do
more than create custom lessons and tests. Behind the

scenes,  the program analyzes the types of  er rors you are

making. This analysis covers transposition errors (for
instance,  "re"  instead of  "er") ,  sh i f t ing your  f ingers  over

to the wrong part of the keyboard, typing the correct
locat ion  but  w i th  the  wrong hand ("mi r ror"  mistakes) ,  or

typing a greater percentage of mistakes with particular
f ingers.

Instead of having to determine your own weaknesses
through complex charts and graphs, the program auto-
mat ica l ly  ad justs  the  lessons  and tests  to  he lp  you over-

come spec i f ic  prob lems.  You  are  ab le  to  concent ra te  on

what  you  are  do ing  r ight  ra ther  than  what  you  are  do ing

wrong. And you can see how you are doing each step

of the way through clearly presented progress reports
and graphs.

These feedback mechanisms are important and pro-
v ide usefu l  in format ion.  However,  the  most  ef f ic ient  way

to build good typing skills is to set goals right from the



start, discipline yourself to set aside specific t imes for
practicing, and ask someone to assist you by encourag-
ing you to meet those goals.  The Typing Tutor IV pro-

9

gram helps you do these things by having you establish

goals and a practice schedule within the context of the
program. From that point on, Typing Tutor IV keeps
track of your progress and offers specif ic feedback to

assist you in meeting your goals.

In addit ion, the Typing Tutor IV program has made it
easy for you to assist others who would also like to learn

how to type. The program includes a special Instructor
Mode and an Instructor's Guide that offers unique
features and techniques for helping others develop ex-
cellent typing skills. It is ideal for classroom, office, and
personal use.

LETTER INVADERS

Learning a new skill is a lot of fun-especially when

you're learning whi le playing games !  The Typing Tutor
IV package includes the new and improved Letter  In-

vaders  game.  Th is  fasc ina t ing  a rcade-sty le  game enab les

you to take a break from the lessons and sharpen your
speed skills in an exciting way. Letter Invaders uses the

results of your lessons to create a game that exactly
matches your level of skill. And it reinforces typing
accuracy-you have to type the words correctly to get
the points! Choose one of two great ways to play-at
your present level  or with the ful l  keyboard. Letter In-

vaders includes Word Ships, Boomlets,  and two-player
competition.

THE TYPING PROGRAM FOR EVERYONE

The Typing Tutor IV program has been designed to ap-
peal to people of all  ages. Over the past few years, the



Typing Tutor products have reached hundreds of thou-

10 sands of people in homes, classrooms, and offices,
generating an enormous amount of research results.
Using this data, the makers of Typing Tutor IV
have created a flexible system of keyboard instruction to

match specific needs.
Although most of the work is done for you in the

creation of customized lessons and tests, you can also
modify the program to suit specific needs. You can
create your own tests of varying length and content and

you can concentrate on specif ic areas of keyboard in-
struct ion depending upon your personal  requirements.
Another important feature is that you can customize
tests to any special ized f ield-legal,  medical,  scientif ic,
or whatever it happens to be.

In addition to flexibility, Typing Tutor IV has been
designed to be long last ing.  You won't  get bored with

repetitive typing material because the sentence patterns
are generated with virtually infinite (and sometimes

humorous !) variety. The lesson material ,  the variety of
feedback, the Letter Invaders game, and many other

features provide the combinat ion necessary to reta in
interest. With sustained interest, practice sessions are

easy and enjoyable. Discover for yourself that learning
can be fun!

Computer Requirements

To run the Typing Tutor IV program and Letter Invaders
game on the Apple Macintosh, you will need 512K of
memory.



Removal and Care of the Disk
11

To remove the disk from the plastic envelope (after you

have  read  the  End  User  L icense  Agreement  i n  the  back  o f

th is  book) ,  use  sc issors  or  a  sharp  kn i fe  to  cut  the  sea l  o f

the envelope's top horizontal edge. After you have made
a backup of the Typing Tutor IV program, return the
original disk to this envelope for safekeeping.

The disk is magnetic and should be handled carefully.
Placing it on or near anything magnetic could erase
information. Objects such as loudspeakers, kitchen ap-
pliances, and paper-clip holders all apply! And try to

avoid the most common cr ime against  d isks,  which is
leaving them on a computer or monitor. Although these
may seem l ike convenient places, you may end up with
damaged disks !

Making a Backup Copy

Copy me first ...

Even  though  you  p lan  to  take  good  care  o f  your  so f tware ,

accidents do happen. Therefore,  i t  is  extremely impor-
tant for you to create a working copy of the Typing Tutor
IV Master disk.

but not more than once.

Please understand that copying this program to sell  or
give to anyone else is against the law. This includes
distr ibution within schools and clubs.

If you are not familiar with the basic Macintosh funda-
mentals and terms, you should refer to your Macintosh

owner's manual .  Fol low the step-by-step instruct ions
below to copy the Typing Tutor IV Master disk.



COPYING THE PROGRAM WITH ONE DISK

12 DRIVE

1. Turn on the Macintosh power switch. A tone will
sound and an icon representing a Macintosh disk
will appear on the screen. The blinking question
mark indicates that the computer is ready for you to

insert the Typing Tutor IV Master disk.

2.  Insert  the Typing Tutor IV Master disk into the disk
drive. The Macintosh will read the information on

the disk and then will display a light gray desktop on
its screen. Notice that the Typing Tutor IV Master disk
icon is present and selected (highlighted).

3. From the Fi le menu at the top of the screen, choose

Eject. When the Typing Tutor IV Master disk is
ejected from the drive,  i ts icon wi l l  "ghost" or dim.

4. Insert a blank disk into the disk drive.

5. If  this disk is unreadable, a dialogue box wil l  appear
asking you whether you'd like to initialize the disk. If
so, cl ick Init ial ize. (You may be given other options.
To init ial ize both sides of double-sided disk, cl ick

Two-Sided. To initial ize a disk sO you can use it in a

400K disk drive, cl ick One-Sided.)

6. Once the disk is initialized, give it a name. A dialogue

box will appear asking you to name the disk. Type
TT IV Working, or some other name you wi l l  recog-
nize in the future.

7. To begin the copy procedure, drag the Typing Tutor
IV Master disk's icon directly over the icon of the
Working Copy disk. Release the mouse. You'll be
asked to confirm that you really want to make a copy.
Click OK.



8. At this point, you'll need to swap disks several times.

Keep up with the messages on the screen and you'l l
have no problem.

13

9. Put the enclosed identifying label on the Working
Copy d isk.  E ject  the Master  and store  i t  in  a  safe  p lace.

COPYING THE PROGRAM WITH TWO
DISK DRIVES

Having a two-drive system greatly simplifies disk copy-
ing. You do not have to swap disks repeatedly, as you do
with one drive. Follow the step-by-step procedure
described in "Copying the Program with One Disk
Drive" but make these changes:

Step 3: There is no need to eject the Typing Tutor IV
Master disk from the built-in drive.

Step 4: The Working Copy disk is put in the external
drive.

COPYING THE PROGRAM WITH A HARD
DISK

1. Boot up your hard disk so that i ts icon or window is

vis ible on the desktop. See your hard disk owner's
manual  for  detai ls .

2. Insert the Typing Tutor IV Master disk into the inter-
nal drive of the computer. Its icon will be selected and
wil l  appear under the hard disk icon.

3. Choose Open from the Fi le menu or double-cl ick on
the Typing Tutor IV Master disk icon. The Typing
Tutor IV Master disk window wil l  zoom open to
a reveal  a directory of  icons.



4. It is necessary to copy only the Typing Tutor IV icon

14 and the three document icons Initial, Quotes, and
Story. To accomplish this, drag them one at a time, or

as a group, from your Typing Tutor IV Master disk to
your hard disk. You do not need to transfer the
System Folder.

5.  Eject the Typing Tutor IV Master disk from the disk
drive and store it in a safe place.

Getting Started

To start the Typing Tutor IV program, turn on the Macin-
tosh power switch and, if you have not installed the

program on a hard disk, insert your Working Copy of the
Typing Tutor IV disk into the disk dr ive.  Choose Open
from the Fi le menu or double-cl ick on the disk icon. A

window will zoom open revealing the contents of the
disk. If this is your first session, double-click on the

Fi le L e s s o n s  Te s t s  R e p o r t s  O p t i o n s b a m e

P r e s e n t i n g . .

Ty p i n g  Tu t o r  ( R )  I V
Ty p i n g  Tu t o r  ( R )  I V

w i t h  L e t t e r  I n v a d e r s  ( R )
W i t h  Le t t e r  I nva d e r s  ( R )

(C)  Copyr ight  1983, d i s c l o s u r e  i s

1987 by  Kr iya  Systens , p ro h i b i t e d  w i t h o u t

Inc. All rights e x p r e s s  w r i t t e n
r e s e r v e d .  P r o v i d e d  f o r p e r m i s s i o n  o f  K r i y a
end users  on ly  under Systens, Inc.,
uritten l icense Ster l ing ,  V i rg in ia .
a g r e e m e n t .  A l l  o t h e r P u b l i s h e d  by  S i m o n

c o py i n g ,  u s e  o r Schuster  Sof tware

The opening screen.



Typing Tutor IV icon. Otherwise, if you have already
created a history file, double-click on that file's icon. 15

You should now see an opening screen containing the

copyr ight  not ice  and a  l i s t  o f  features  across  the  top  ( th is
list is referred to as the menu bar).

Position the pointer on the menu title File on the
menu bar and press the mouse button. If this is your first

session with Typing Tutor IV, select New Student. In
future sessions, you will select Continue Lesson.





YOUR FIRST SESSION

Getting Acquainted

The first step in using Typing Tutor IV is to register
yourself with the program. After you select New Student
from the File menu, you are asked to enter your name so

that  the program can track your  progress and keep a
history file of your work. In all subsequent sessions,
double-cl ick on the icon with your name to open your

history f i le and continue your work.

As a first-time user, you are given an introduction to

the program that orients you to its key features. Then you

are asked about your previous typing experience to help
the Typing Tutor IV program create the best type of

lessons for  you.  I f  you can type at  least  20 words per
minute without looking at  the keys,  choose the Touch
Typist selection. Touch typists receive an initial test
using all  the letters of the alphabet. With this informa-

tion, the program wil l  know your typing speed on every
key and will create lessons to overcome any weak areas.

Goal Setting

The best way to improve your typing skil ls dramatically

is through consistent practice. To help motivate yourself

to keep pract ic ing,  set  a  goal  of  how many words per
minute you wish to type. Give yourself a deadline for
achieving this goal.  Then, before you sit  down to prac-
tice each time, put yourself in a positive frame of mind
that wil l  help you reach your goal.

Because of the importance of setting goals, the Typing
Tutor IV program asks you to select the words-per- 17



minute speed you would l ike to achieve. The program
18 highl ights a suggested a speed range,  based on your cur-

rent level of experience, which you can easily increase
or decrease. Then it asks you to select the number of

hours per week you intend to practice. Again, the pro-
gram wi l l  h igh l ight  a  suggested pract ice  t ime,  which can
be changed to  su i t  your  schedule .

To help you achieve your  weekly  goal ,  use the pract ice

schedule provided in this manual and schedule specific
days  and  t imes  to  prac t ice .  Do  everyth ing  in  your  power

to stick to those t imes. The Typing Tutor IV program
records your time in each session and offers periodic

feedback to  he lp  you measure  your  progress .

I f  your  schedule  changes or  i f  you  wish  to  increase  or

decrease  your  speed goa l  a t  a  la ter  t ime,  you  may do  so
through the Options menu, described later in this
manual. However, please remember that the first few

hours are often the most  d i f f icu l t  for  beginners,  so don't

get discouraged if it seems a little slow going at first.
You' l l  get better !  Try not to change your goals unti l
you've  rea l ly  had a  chance to  see what  you can do.

Guided Tour

After you have set your goals in your first session with

Typing Tutor  IV,  you have the choice of  go ing d i rect ly  to

the Pract ice Lessons,  tak ing a  Pract ice Test ,  or  se lect ing

from the  menu bar  a t  the  top  of  the  screen.  C l ick  on  the

Select from Menu option.
For a quick overview of each of the categories l isted on

the menu bar,  read the Help  screens ava i lab le  f rom each

pull-down menu. Explore the program as much as you
want  to ,  then  se lec t  Prac t ice  f rom the  Lessons  menu  to

begin developing your typing skills. If you are a begin-
ner,  the  lessons  beg in  w i th  the  "home row"  keys  for  the

le f t  hand:  ASDF.  Touch typ ists  beg in  w i th  lessons  based
on the resul ts  of  the i r  in i t ia l  t imed test .



Practice with the lessons for a while. Then, when you

have practiced as much as you want to, select another 19
feature or select Quit from the File menu. If you choose
to quit, you will have the option of saving your work. It is

important to save your work after each session so that an
accurate history file of your progress can be maintained.

The next chapter provides you with a few suggestions

for creat ing effect ive future sessions with the Typing

Tutor IV program. This is followed by reference material
that  exp la ins  each  of  the  Typ ing  Tutor  IV  key  features .  By

the end of your f irst session, you'l l  have a pretty good

understanding of what is available to you in the program
and the manual.  After you've reviewed the manual and

prac t iced  a  b i t  w i th  the  lessons ,  we  suggest  you  end  your

first session by taking a few minutes to decide how you
want to structure future sessions so that you can make

the most out of your Typing Tutor IV experience.





TYPICAL SESSIONS

Beginners:  Your f i rst  goal  should be to learn the loca-

tion and correct fingering for the alphabet and punctua-

tion. To do so, spend at least 60 percent of your time in
the Practice Lessons section of the program typing prac-

t ice dri l ls.  Every f i fteen minutes or so, take a Practice

Test to see how wel l  you are typing the keys you have

learned.

As more and more new keys are introduced, refer
frequently to the f ingering diagram in this manual and

the Fingering Lesson section in the program to reinforce
use of the correct f ingering continuously. Always keep

your f ingers posit ioned over the home row keys (ASDF
for the left hand and JKL; for the right hand), and reach

from there to type any other key on the keyboard. Avoid
looking at  the keyboard when typing try  to remember
the positions of the keys by feel and not by sight.

Once you have learned the home row keys, take at
least one good break in the middle of each session for a
Letter Invaders game. Hint: You'll achieve the highest
scores if you concentrate on using the correct fingering

while you play the Letter Invaders game. Don't fal l  into
the trap of two-f inger typing i t 's a dead end !  Also,  be
sure to select Practice Keys-that way, you'll have a
challenging game that uses only the keys you have
learned.

Touch Typists:  As a touch typist  you should be able
to type without looking at the keys. However, you may
not  have  reached  the  po in t  where  you  can  type  au tomat i -

cally, without thinking about each key. In order to brush
up your typing ski l ls  and develop speed and accuracy
on the entire keyboard, you may want to divide your
time evenly between lessons and tests. 21



The advantage of  the lessons is  that  the program

22 modif ies  the mater ia l  presented to  you af ter  each phrase
instead of after an entire page of  text .  The advantage of

tests is that you can type continuously for a longer
period of time without stopping. Focus on the Practice

Tests.  These tests are created based on the keys you type

wel l ,  introducing new keys at a chal lenging, but not
overwhelming, pace. Save the All-Keys Test until later,
when you're ready to tackle some of those esoter ic
symbols!

To make your work most enjoyable, take periodic
breaks  to  p lay  Let ter  Invaders .  S ince you know the  loca-

tions of all the keys, you'll be in for a really challenging
game.  Go for  the  h igh  scores  and t ry  to  reach the  top  of
the char t  of  a l l -t ime h igh scorers !

Advanced Touch Typists: If you have already devel-
oped prof ic ient  typ ing sk i l ls  on the a lphabet  and need to

i n c re a s e  yo u r  s p e e d  o n  n u m b e rs  a n d  sy m b o l s ,  yo u  m ay

wish to spend a lot of practice time with the All-Keys
Test .  Wi th  th is  test ,  you wi l l  rece ive  typ ing mater ia l  that

includes all of the keys on the keyboard. Alternate with
Prac t ice  Lessons .  Based on  your  typ ing  resu l ts ,  you  w i l l

be g iven extra  pract ice on your  s lowest  keys.

When you need per iodic breaks from lessons and
tests,  select the Ful l  Keyboard Letter Invaders game. This

one will keep your fingers flying!

Keypad Typists: If  your special area of expertise is
"number crunching," you'll want to use Typing Tutor IV

to develop your skills with the keypad. We suggest you
spend at least 60 percent of your time with the Keypad
Lessons, with the remainder of your time spent on
Keypad Tests .  A  few good sess ions  wi th  these  two areas

and you'l l  be a speed demon on any numeric keypad !
Regardless of your particular interest or level of ex-

per ience,  remember  that  you can break  up your  sess ions
at any time by looking at your Progress Report or at a
Speed or Accuracy Graph.



REFERENCE

Keyboard and Keypad Lessons

Practice Lessons is the place to learn all the positions of

the keys using correct fingering. With practice, you'll be

able to type automatically, without having to remember
the location of each key. And you'll develop overall

speed and accuracy so that you won't have to slow down
for keys that are less commonly used.

The lessons consist of a set of drills that are presented

one phrase at a time. Based on your responses, another

phrase is presented. Your accumulated results are used

continuously to adjust the letters that are presented in

each new phrase. New keys are introduced gradually as

your speed and accuracy levels become consistent on
previously learned keys.

For beginners, lessons begin with the home row keys,
ASDF for the left hand and JKL; for the right hand. The

key to typing automatically, without looking, is to prac-
tice using the correct fingering right from the start. Al-
ways position your fingers over the home row before

beginning to type. From the home row, your fingers can
comfortably and methodical ly reach al l  the other keys
on the keyboard. The accompanying keyboard diagram
illustrates how correct fingering works on the keyboard

and keypad.
Notice how the keyboard is divided into areas. Each

finger is responsible for the keys in its area. The index
fingers cover the areas numbered 1; the middle f ingers
cover the number 2 areas; ring fingers work the keys in

the areas numbered 3; and little fingers cover the keys in 23
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the areas numbered 4. The space bar works easily with

the thumbs. The Shift keys should be pressed with the

little finger of the hand that is not making the keystroke.
25

Whenever you practice the keyboard lessons, position
your hands over the home row keys and type each
character that the arrow (1 ) points to. Before beginning,

look at the Current Focus Keys box and make sure you

know where those keys are and which fingers you need
to use to type them.

If  you aren't  sure of  correct  f inger ing,  e i ther  refer  to  the

Fingering section of the program (choose it from the
Lessons menu) or refer to the diagram in this manual.
After you have typed al l  the words in the lesson,  your
speed and accuracy wil l  be shown, along with the next
set of words to be typed.

On the screen, an arrow (4) above the line you are
typing indicates that you have made a mistake. If you

File Lessons Tests Reports Opt ions Game

P r a c t i c e  Le ss o n

One affi l iate (attacking

C u r r e n t  F o c u s  Ke y s :  (  f  c

Type the  l ine  in  the  top  box .  The  ar row moves  to
show the  nent  key  to  type .  A1  the  end  o f  the  l i ne
press  e i ther  the  space  bar  or  the  Return  key.

A  typ ica l  Pract ice  Lesson.



make a mistake, you can press
26

the Backspace key to
correct i t .

Practice Lesson Summary displays your average
speed and accuracy f igures at  the end of  each lesson for

the preceding set of drills. The summary also indicates
how many keys  you have typed above the words-per-

minute figure you specified in your speed goal. Finally,
it shows your best keys and the ones you need to work

on.  From th is  po int  you can cont inue the lessons,  take a
Prac t ice  Test ,  o r  make  another  se lec t ion  f rom the  menu

bar.

Keypad Lessons build skills for use with a calculator
or  any  numer ic  keypad.  I f  your  keyboard  has  a  keypad or
if you have a keypad connected to your  Macintosh,
select Keypad from the Lessons menu. You will be
shown an  out l ine  of  the  keypad,  w i th  the  home row keys

4, 5, and 6 highlighted. Position the index, middle, and
ring f ingers of the r ight hand over the 4, 5, and 6 keys and

reach from these posit ions to type the 1,  2,  3,  7,  8,  9,  and

keys. The 0 is typed with the index finger. The lesson
numbers are presented in varying lengths to closely
simulate actual l ists of numbers. Press the Enter key

wi th  your  l i t t le  f inger  to  move f rom one l ine  to  the  next .

Keypad  Lesson  Summar y  d i sp lays  ave rage  speed  and

accuracy f igures at  the complet ion of  each lesson for  the
preceding set of drills. It shows the number of keys you
type over your speed goal, your best keys, and those
needing more practice. From this point you can con-

t inue with the lessons,  take a Keypad Test,  or  make
another  se lec t ion  f rom the  menu bar.

Fingering

One of the Typing Tutor IV sections you will refer to

often is  F inger ing.  Se lected f rom the Lessons menu,  th is
sec t ion  shows an  out l ine  o f  the  keyboard  w i th  the  home

row keys highlighted.
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AS D2xcvBNm >/?

F i n g e r i n g  P r a c t i c e  /

T h e  h i g h l i g h t e d  ke ys  a re  t h e  h o m e  ke ys .  T h e  l e f t  h a n d  i s  o u e r A S D F '

The l i t t le  f inger  types A',  r ing f inger  'S '
i n d e x  f i n g e r

m i d d l e  f i n g e r  ' 0 ',  a n d
T h e  r i g h t  h a n d  i s  o v e r  'J K L ; ',  T h e  i n d e x  f i n g e r

Lypes '  J',  middle f inger 'K',  r ing f inger 'L',  and l i tt le f inger

P re ss  a ny  n o n - h o m e  key  fo r  a  f i n g e r i n g  l e ss o n  o n  t h a t  key

F inger ing  Lesson.

Press any key other than the home row keys to review

the correct f inger to use for that key and to receive a
home key lesson.

The home key lesson wil l  consist of a series of dri l ls

using the key you selected and its corresponding home
row key. All of the keys on the keyboard are divided into

areas,  with each home row f inger  cover ing a specif ic

"territory." These dri l ls help you to remember the key-
board position and correct fingering for any key you
choose because the entire dril l  is typed using the same

finger. Use this section at any time to help you with keys
on which you need extra practice.

Tests

Four different types of tests are available with the Typing

Tutor IV program- -Practice, All-Keys, Disk, and Keypad
(avai lable i f  your keyboard has a keypad or you have a
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keypad connec ted  to  your  computer ) .  The  Prac t ice  Test

is based on the results of your lessons. If you are just
beginning the lessons, the test wi l l  only include the

home row keys for the left hand, ASDF. Otherwise, the
test  wi l l  inc lude a l l  the characters  you have learned thus

far, with special emphasis on the keys you type most
slowly.

The All-Keys Test means just that-all the letters,

numbers,  and symbols  are  used.  The purpose of  th is  test
is  to  see  how you would do using the full keyboard. The

Al l-Keys Test  is  recommended for  typists  who have
already learned the alphabet and punctuation and
would l ike to increase their overall typing skil ls, par-
ticularly on symbols that are not used in everyday
language.

The main purpose of the Disk Test is to provide you
with the facility for setting up your own tests using the
content  of  your  choice.  Three sample tests  are stored on

the disk and can be used at any time. One is the initial

test that is used to assess a touch typist's previous typing

experience and level. Another is a fun and interesting

test  made up of  quotes,  and the th i rd is  a  story.  Both the
quotes and story tests show you how wel l  you type over a

longer period of t ime-the length of both tests is two
screen "pages."

You can add as many tests to the disk as you like

(within the l imits  of  the disk space,  of  course).  The tests
you add can be as long as you want. They can include
anything from legal or medical jargon to inspirational
quotat ions l ike  the Gettysburg Address.  Th is  feature was

implemented to enable you to customize tests for your
specif ic  f ie ld  of  interest .  The procedure for  creat ing your
own tests is  descr ibed in the next sect ion of  th is manual .

The  four th  and f ina l  type  of  test  ava i lab le  w i th  Typ ing

Tutor IV is the Keypad Test. It consists of several col-
umns  of  numbers  and  tests  your  ab i l i ty  to  ma in ta in  h igh

speed and accuracy levels over longer periods of time.



CREATING YOUR OWN TESTS

Creating your own tests is a simple procedure. Tests can
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be created with MacWrite or any word processor or
editor that can make an ASCII f i le ("Text Only") without

any special characters (such as those used for boldfacing

or i tal ics).  Simply create your test,  of  any length,  and
save it as a Text Only file. The name of your file will
appear in the selection box when you select Disk from
the Tests  menu.  (Note:  Your  test  f i les  do not  need to  be on

the  same d isk  as  the  Typ ing  Tutor  IV  p rogram,  so  you  can

create as many as youwant on a separate disk.)

Reports and Graphs

The Typing Tutor IV program offers many different types
of feedback throughout the program. In the lessons,
speed and accuracy f igures are shown after each dri l l .

Each lesson ends with a summary that  h ighl ights your
best keys and the keys you need to work on. Each test is

followed by a summary in the style of a progress report.
It shows your overall  speed and accuracy, as well  as a
breakdown of your speed on letters, numbers, and
symbols.

All  the feedback you are given in the Typing Tutor IV
program re lates  to  your  words-per-minute speed and
your accuracy percentage. Before word processors
became widespread, typing teachers typically down-
graded for errors and gave a figure called "corrected
speed."

Since mistakes are now so easy to correct with the

Backspace key, the common practice is to calculate un-
corrected speed and report this together with an ac-
curacy figure. Speed is calculated in words per minute,
where a word consists of f ive characters including
spaces. Typing Tutor IV reports accuracy as the percen-

tage of characters correctly typed. An accuracy figure of



97 percent indicates an average of approximately two
30 mistakes  per  l ine  on  a  test .  As  you  ga in  exper ience,  you

should aim for accuracy in the high 90's, and you may

want to use the Backspace key to attain 100-percent

In addition to the feedback you are given with each

accuracy.

lesson and test ,  the Typing Tutor  IV  program mainta ins  a

complete  progress  repor t  o f  your  work .  Choose  Progress

have taken,
from the Reports menu for a summary of  your work,
inc lud ing the  types  of  lessons  and tests  you

complet ion dates,  the number  of  keys you type above the

words-per-minute figure you established in your goals,
your overall accuracy and speed, and a breakdown of
speed by letters (including punctuation), numbers, and

The Progress Report  d isplays test  results  f i rst  with the

symbols .

most recent dates at the top. Results of a maximum of
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eight tests can be displayed at one time. Of these, only
four can be Disk Tests. If you are a touch typist, the 31
results of your initial test will always be displayed so

that you can compare them with your current results.
Fol lowing the tests summary is  a  review of  Pract ice

Lessons for the keyboard (and keypad, if you have prac-

ticed this). Once you have fi l led the maximum area that

can be displayed on the screen, only your most recent
data (plus initial test data, if appropriate) is shown.
Summaries for  lessons and tests  are broken down by

session and history. Session refers to your most current

work, and history provides you with average figures
from previous sessions.

In addition to the Progress Report, two graphs are also

included in this program--a Speed Graph, which shows
your words-per-minute speed on each character, and an
Accuracy Graph, which shows your percentage of ac-

Fi le Lessons Tests Reports Options Game

Speed  Graph  -  Ba rbara

a s d f j k l ; e i t . n r o , h c p u myg w v bxq z ' : " ? !C ) - 4

S e s s i o n H i s t o r y S p e e d  G o a l

Speed  Graph .
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a s d f j k i ; e i t . n r o ,  h c p u m y g e u b x g

S e s s i o n H i s t o r y

Accuracy Graph.

curacy on each character. Why is this important? It is

another way of looking at your overall progress and
pinpointing your weakest keys. With this information,
you can use the F inger ing sect ion to  refresh your  memo-

ry on key positions and to receive practice dri l ls that
will help you build speed and accuracy on those keys.

Look at the legends displayed on the graphs-the
program shows results from the current session, pre-

v ious  h is tory,  and  a reas  where  cur rent  sess ion  and  h is-

tory  over lap.  The  pur pose  o f  the  graphs  i s  to  char t  your

progress over  t ime.  You can see how you are doing in  the
current session as compared with previous sessions.
You can also see which keys you have improved upon
with  pract ice  and note  which  keys  you cons istent ly  type

well. The keyboard numbers are shown with letters and
symbols. Keypad numbers are listed on the right-hand
side of the screen.



Options
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The Options menu lets you customize features of  the

program. You can change the words-per-minute goal you

designated at the beginning of the program, or you can

alter your practice schedule. It's possible to alter the
number of drills that are given to you in each lesson, turn
the sound on or off, or even reread the introduction. All

of the choices listed on this menu are more fully
described in the Help screen for this section.





LETTER INVADERS GAME

Caution: This game may be habit forming! The Letter
Invaders game provides a great break from the usual
typing dril ls. Select Play from the Game menu and
follow the instructions that are shown on the screen.

Players can choose a game using Practice Keys or Full
Keyboard. If you choose Practice Keys, the game will
only use keys famil iar  to you from your lessons. How-

ever, be aware that even a Practice Keys game will start
out by using all  the home row keys, ASDF and JKL;. We
recommend that you do not play Letter Invaders until
you have learned the home row in the lessons.

If you are already familiar with the keyboard and want
to select a truly challenging game, choose Full Key-

Fi le Lessons Tests Reports Options Game
S co re :  4261

J

J

a ide

1 3 F a k e .

100
jail

h u m a n e
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Letter  Invaders  in  p lay. 3 5



board. But be prepared-this game will use all letters,

36 numbers,  and symbols.  Ful l  Keyboard Letter  Invaders

will  keep your fingers flying!
For two-player games, the second player types in his

or  her  name.  Both  p layers  compete  a t  the  leve l  o f  the  one

whose fi le is currently "opened."
The object of the Letter Invaders game is to score as

many points as possible by typing all the letters and
words before they hit the "terrain" at the bottom of
the screen. You'll be bombarded by letters, words,
Boomlets, and Word Ships in many interesting com-
binat ions.

Remember to use the Shift key to type capital letters.
The game is over when all the terrain has been
destroyed. To cancel a game in progress, hold down the

Command key (9)  whi le  typ ing a  per iod.

The f ive al l-t ime high scores for both Pract ice Keys

and Full Keyboard games are shown on the scoreboard.
You can look at the scoreboard by selecting Scores from

the Game menu. Play Letter Invaders with your fr iends
and see how many points you can rack up in each game!



INSTRUCTOR'S GUIDE

Overview

Typing Tutor IV has been designed for  maximum f lex-
ibi l i ty and ease of use in an instructional sett ing. It  is

ideal for a school classroom or for increasing typing and

data-entry productivity in the office. The history file on
your program disk can hold up to eight students, so that
students coming to a computer station at different times

can share the same program disk.  The instructor  can

look at this disk at any time with the Instructor Mode of
Typing Tutor IV and review each student's progress, add
tests for students to take, and remove old student

records. For security, a password is required to get into

Instructor Mode. You also have the option of setting up
passwords for each of your students to protect individ-
ual records in disk-sharing situations.

Your  l i cense  agreement  a l l ows  you  to  have  one  copy  o f

the program running at  a  t ime.  Mult ip le  students can
share a single disk if they are using the program at
dif ferent  t imes.  For  s imultaneous use,  you must  have

multiple licensed copies of the program. For example, a
c lassroom that  has  a  computer  s tudy  a rea  w i th  four  com-

puters would need four l icensed copies of Typing Tutor
IV. With eight student records on each disk, up to thirty-

two students could be using the program through
the day.

Getting Started in Instructor Mode

To enter the Instructor section of Typing Tutor IV, start
the program as you normally would, then select Instruc- 3 7



tor Mode from the File menu. The password for entering

38 the Instructor section is hello. Type hello and press
Return or click on the OK button.

PASSWORD

You can change your password from hel lo to any other
combination of up to five characters. To change the
password, select Instructor Password from the Options

menu. Type a new password of f ive characters or less
and click OK, or select Cancel to keep the same
password.  You can make your password whatever you
like, but make it something you wil l  remember!  Write it
down also, and keep it in a safe place.

In addit ion to the password needed to enter the In-

structor Mode, you can set up all of your students with
individual passwords. Select Student Password from
the Options menu to display the names of all the
registered students on the screen. Selecting students
from this list will allow you to review or edit existing
passwords, or enter passwords for new students.

Be sure  to  ass ign  passwords  that  are  easy  to  remember,

but hard enough so that  other students cannot easi ly

enter other people's records. Once you have set up

passwords for each student, they will need to enter their
passwords before using Typing Tutor IV in all subse-
quent sessions. Use this feature of Typing Tutor IV only
if you are concerned with safeguarding the data of stu-

dents when a single disk is being shared.

Giving Tests

Typing Tutor IV makes it  easy for an instructor to give

the  same typ ing  test  to  a  group of  s tudents .  The  f i rs t  s tep
is to create a Disk Test using an editor or word processor
as explained in "Creating Your Own Tests." The next
step is to encrypt the test.  Encrypting a test makes it



unreadable except when taking the test by selecting Disk|
from the Tests menu.

To encrypt a test, select Encrypt from the Options
39

menu. You will see a list of all the unencrypted test files
on the disk. If you select one for encryption, the file will

be written in encrypted form to the disk.  Your or iginal

fi le wil l  no longer exist in unencrypted form, so make a
backup copy of it before doing the encrypt procedure if

you wil l  want to use it again!  If  you are using more than

one l icensed copy of Typing Tutor IV, you can copy the
encrypted file to other Typing Tutor IV program disks.

Students can take the test you create by starting
Typing Tutor IV and selecting Disk from the Tests menu.
They wil l  see a l ist of Disk Tests, and should select the

new test by name. When an encrypted test is selected, it

is not possible to leave the test without recording a result
in the history file. After all students have taken the test,
their  results can be reviewed as descr ibed in the next
section.

Reviewing Student Records

The Reports menu offers the instructor the opportunity
to review individual or group records. The choiceson

the Reports menu are Progress, Speed, Accuracy, Com-
posite,  and Help.

If  you choose Progress, Speed, or Accuracy, you wil l
need to select the name of the f i le you wish to review.
After identify ing a student,  you wi l l  see the individual

Progress Report or the Speed Graph or Accuracy Graph

for that student. This allows you to review overall
progress and assess the student's strengths and areas
needing improvement.

A Composite Report al lows you to see a summary of
how all students performed on a particular Disk Test.

After selecting Composite, you wil l  be asked to choose
the test for which you wish to view results. A typical
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summary is  shown in the accompanying i l lustrat ion.
Beside each student's  name is  the date on which the test

was taken and then speed and accuracy figures similar
to those in  the standard Progress Report .

Deleting Student Records

The Typing Tutor IV program provides extra security to
protec t  s tudent  f i l es  f rom be ing  acc identa l ly  dest royed.

Instead of  a l lowing you to destroy these f i les  by dragging

their icons to the Trash, as you would normally do in

Mac intosh  sof tware ,  Typ ing  Tutor  IV  permi ts  de le t ion  of

student records only in Instructor Mode. If you need to
delete a student's history f i le,  select Delete Student from

the Options menu. Select the student history fi le you
wish to delete and select open.  This erases al l  h istory for
that individual.



Restoring Icons
41

It is possible, outside of the Typing Tutor IV program, to
drag a student's icon to the Trash and then empty the

Trash. Perhaps this would happen as an accident.  This
would cause the student's icon to disappear but would

not delete the student's history; that can only be done in
Instructor Mode. If a student icon does get trashed.

select Restore Icon from the Options menu in Instructor
Mode and cl ick on the name of the student whose icon

you wish to restore. An icon for that student wil l  appear

on the Typing Tutor IV disk window, enabl ing the stu-
dent to keep using the program.

Setting Up a Training Program

The Typing Tutor IV software can easily be used in a
group setting to teach or dramatically improve typing

skills. The following information is for you to use to
ensure that each participant completes your training
program with opt imal  results.

Whether you are establ ishing a training program for

classroom, off ice,  or  home use,  the f i rst  step is  to  set  up a

two-hour group session with all participants. Ideally,
each person should have access to a computer dur ing
this session. If this is not possible, try to l imit a shared

computer to two people.
In the initial session you will explain the key func-

t ions of  the Typing Tutor IV software.  Begin by taking
students through the steps to complete their speed and
practice goals. As you will realize through your own
practice with the program, these goals can reside on disk
for each participant. In addition, duplicate the schedule

form provided in this package and ask each person to fill

i t  out.  That way, you can enhance the program's auto-



matic monitoring and feedback through personal con-

42 tact with each participant.

Al l  par t ic ipants  who are  able  to  type at  least  20 words
per minute should take an initial t imed test, and their
scores should be written onto their practice schedule
sheets .  I f  s tudents  a re  beg inners  who  have  never  typed

before, insert zeros in the init ial speed and accuracy
s lots .  You wi l l  need to  have  a  bas is  for  compar ison  once

ever yone  has  comp le ted  the  t ra in ing  p rogram.

It is important that each person set aside sufficient

time to practice with the software. Participants should
write down specif ic dates and t imes when they plan
to practice. Although Typing Tutor IV makes learning
an enjoyable and rewarding exper ience,  there is  no

substitute for practice. Consistent practice during the
first few weeks of the training program is crucial to
overall improvement. One of your most important func-
tions as instructor is to follow up with each person to

make sure the requirements of the course are being
fulf i l led in a t imely fashion.

F ina l ly,  a f ter  set t ing  goa ls  and complet ing the  pract ice

schedule  form,  go through each par t  of  the program with

the participants and explain all of Typing Tutor IV's key
features to facilitate ease of use. You will want to take

each step slowly and emphasize key points,  such as
us ing  cor rec t  f inger ing ,  keep ing  f ingers  curved over  the

home row keys,  and keeping eyes on the screen-
-not on

the keys !  After  pract ic ing together  as  a  group for  a  whi le ,

each person should  fee l  comfor tab le  cont inu ing to  prac-

t ice a lone.  From that  point  on,  your  job wi l l  be to oversee
progress and encourage cons istency  in  prac t ice .

The  fo l lowing  are  some ideas  to  encourage  mot ivat ion

and create a  group spir i t  that  can help a l l  par t ic ipants  in

the training program develop skills to the best of their
abil it ies.

Letter Invaders Contests: Keep a running score on

your  c lassroom or  of f ice  bu l le t in  board showing who has

the highest score for  Letter  Invaders.  Publ ish the name of



the winner for the month in the school bulletin or an
interoff ice memo.

Awards for Greatest Increase: Let all participants
43

know that the greatest increase is the true test of ac-
complishment. Once a week, give: special award to the

person who has increased speed and accuracy the most
during that week. In a classroom setting, the award may
mean extra bonus points and a higher grade. Awards in

an off ice sett ing can range from a bonus to a free a lunch to
extra time off work.

Themes:
Offer periodic tests using interesting and

varied test material. For instance, you can create

different themes each week. For classrooms, create typ-
ing tests using material  that t ies in with work in other

sub jec ts  or  cur rent  school  events .  For  of f ice  use,  you may
want to create tests on different types of terminology
each week, such as medical or legal terms.

Try to create posit ive incentives so that your class-
room, off ice, or department can pride itself  on its ac-

complishments. Our goal with the Typing Tutor IV
software is to make the development and building of
typing speed and accuracy skil ls as easy and enjoyable
an experience as possible.

After your training program has ended, a have a group
follow-up session to compare results and provide an
opportunity for positive feedback. We hope you enjoy
putting this software into practical use in a variety of
classroom, office, business, and personal settings.



TYPING TUTOR IV
PRACTICE SCHEDULE FOR

GOAL: My goal is to type words per minute, with

% accuracy.  My commitment  is  to  achieve th is
goal by

Fill in the times you plan to practice your typing with

the Typing Tutor IV software package. Then check (v)
each practice session as you complete it.

We recommend that you practice 30 minutes a day for
the f i rst  three weeks.  Then pract ice  at  least  2-3 t imes per

week for 20-30 minutes a day in subsequent weeks.

Mon. Tues We d . Thurs. Fri.

Week of:

Week  o f :

Week of:

Week  of :

Week of :

Week of :

Week of:

In it ia l  typing speed: Accuracy percentage:

Ending typing speed: Accuracy percentage:
Date: Signed by:



FOR ADDITIONAL HELP

If you have questions or need more help, call our Product
Support  Center :

(201)  592-2900





Important !  Read Before Opening Sealed Diskette
END USER LICENSE AGREEMENT

T h e  s o f t w a r e  i n  t h i s  p a c k a g e  i s  p r o v i d e d  t o  Y o u  o n  t h e  c o n d i t i o n  t h a t  Y o u  a g r e e  w i t h  K R I Y A  S Y S T E M S ,  I N C .

( * K R I YA" )  a n d  S I M O N  &  S C H U S T E R ,  I N C .  ( * S & S * )  t o  t h e  t e r m s  a n d  c o n d i t i o n s  s e t  fo r t h  b e l o w.  R e a d  t h i s

E n d  U s e r  L i c e n s e  Ag re e m e n t  c a re f u l l y.  Yo u  w i l l  b e  b o u n d  by  t h e  t e r m s  o f  t h i s  a g re e m e n t
i f  you open the sealed d iskette.  I f  You do not  agree to  the terms conta ined in  th is  End User

L i c e n s e  A g r e e m e n t ,  r e t u r n  t h e  e n t i r e  p r o d u c t ,  a l o n g  w i t h  y o u r  r e c e i p t ,  t o  S i m o n  &  S c h u s t e r  S o f t w a r e ,  O n e

G u l f  +  We s t e r n  P l a z a ,  1 4 t h  F l o o r,  N e w  Yo r k ,  N e w  Yo r k ,  1 0 0 2 3,  At t :  Re f u n d s ,  a n d  yo u r  p u rc h a s e  p r i c e  w i l l
b e  r e f u n d e d .

K R I Y A  g r a n t s .  a n d  Y o u  h e r e b y  a c c e p t ,  a  p e r s o n a l ,  n o n e x c l u s i v e  l i c e n s e  t o  u s e  t h e  s o f t w a r e  p r o g r a m  a n d

a s s o c i a t e d  d o c u m e n t a t i o n  i n  t h i s  p a c k a g e ,  o r  a n y  p a r t  o f  i t  ( * L i c e n s e d  P r o d u c t * ) ,  s u b j e c t  t o  t h e  f o l l o w i n g  t e r m s
a n d  c o n d i t i o n s :

1.  L icense
T h e  l i c e n s e  g r a n t e d  t o  Y o u  h e r e u n d e r  a u t h o r i z e s  Y o u  t o  u s e  t h e  L i c e n s e d  P r o d u c t  o n  a n y  s i n g l e  c o m p u t e r

s y s t e m .  A  s e p a r a t e  l i c e n s e .  p u r s u a n t  t o  a  s e p a r a t e  E n d  U s e r  L i c e n s e  A g r e e m e n t ,  i s  r e q u i r e d  f o r  a n y  o t h e r

c o m p u t e r  s y s t e m  o n  w h i c h  Y o u  i n t e n d  t o  u s e  t h e  L i c e n s e d  P r o d u c t .

2.  Term
T h i s  E n d  U s e r  L i c e n s e  A g r e e m e n t  i s  e f f e c t i v e  f r o m  t h e  d a t e  o f  p u r c h a s e  b y  Y o u  o f  t h e  L i c e n s e d  P r o d u c t  a n d

s h a l l  r e m a i n  i n  f o r c e  u n t i l  t e r m i n a t e d .  Y o u  m a y  t e r m i n a t e  t h i s  E n d  U s e r  L i c e n s e  A g r e e m e n t  a t  a n y  t i m e  b y

d e s t r o y i n g  t h e  L i c e n s e d  P r o d u c t  t o g e t h e r  w i t h  a l l  c o p i e s  i n  a n y  f o r m  m a d e  b y  Y o u  o r  r e c e i v e d  b y  Y o u .  Y o u r

r i g h t  t o  u s e  o r  c o p y  t h e  L i c e n s e d  P r o d u c t  w i l l  t e r m i n a t e  i f  Y o u  f a i l  t o  c o m p l y  w i t h  a n y  o f  t h e  t e r m s  o r

c o n d i t i o n s  o f  t h i s  E n d  U s e r  L i c e n s e  A g r e e m e n t .  U p o n  s u c h  t e r m i n a t i o n  Y o u  s h a l l  d e s t r o y  t h e  c o p i e s  o f  t h e

L i c e n s e d  P r o d u c t  i n  y o u r  p o s s e s s i o n .

3.  Restr ic t ion Against  Transfer
T h i s  E n d  U s e r  L i c e n s e  Ag r e e m e n t ,  a n d  t h e  L i c e n s e d  P r o d u c t ,  m ay  n o t  b e  a s s i g n e d ,  s u b l i c e n s e d  o r

o t h e r w i s e  t r a n s fe r re d  by  Yo u  t o  a n o t h e r  p a r t y  u n l e ss  t h e  o t h e r  p a r t y  a g re e s  t o  a c c e p t  t h e  t e r m s  a n d

c o n d i t i o n s  o f  t h i s  E n d  U s e r  L i c e n s e  A g r e e m e n t .  I f  Y o u  t r a n s f e r  t h e  L i c e n s e d  P r o d u c t ,  Y o u  m u s t  a t  t h e  s a m e

t i m e  e i t h e r  t r a n s f e r  a l l  c o p i e s  w h e t h e r  i n  p r i n t e d  o r  m a c h i n e - r e a d a b l e  f o r m  t o  t h e  s a m e  p a r t y  o r  d e s t r o y  a n y

c o p i e s  n o t  t r a n s f e r r e d .

4.  Restr ict ions Against Copying or Modifying the Licensed Product
T h e  L i c e n s e d  P r o d u c t  i s  c o p y r i g h t e d  a n d  m a y  n o t  b e  f u r t h e r  c o p i e d  w i t h o u t  t h e  p r i o r  w r i t t e n  a p p r o v a l  o f

K R I Y A .  e x c e p t  t h a t  Y o u  m a y  m a k e  o n e  c o p y  f o r  b a c k u p  p u r p o s e s  p r o v i d e d  Y o u  r e p r o d u c e  a n d  i n c l u d e  t h e

c o m p l e t e  c o p y r i g h t  n o t i c e  o n  t h e  b a c k u p  c o p y .  A n y  u n a u t h o r i z e d  c o p y i n g  i s  i n  v i o l a t i o n  o f  t h i s  A g r e e m e n t

a n d  m a y  a l s o  c o n s t i t u t e  a  v i o l a t i o n  o f  t h e  U n i t e d  S t a t e s  C o p y r i g h t  L a w  f o r  w h i c h  Y o u  c o u l d  b e  l i a b l e  i n  a  c i v i l

o r  c r i m i n a l  s u i t .  Yo u  m ay  n o t  u s e ,  t r a n s fe r,  m o d i f y,  c o py  o r  o t h e r w i s e  re p ro d u c e  t h e
L i c e n s e d  P r o d u c t ,  o r  a n y  p a r t  o f  i t ,  e xc e p t  a s  e x p r e s s l y  p e r m i t t e d  i n  t h i s  E n d  U s e r
L i c e n s e  Ag re e m e n t .  Yo u  a g re e  t o  m a i n t a i n  a p p ro p r i a t e  re c o rd s  o f  t h e  l o c a t i o n  o f  b o t h  c o p i e s  o f  t h e

L i c e n s e d  P r o d u c t ,  o r  a n y  p a r t  o f  i t .  T h e  o r i g i n a l  a n d  t h e  c o p y  o f  t h e  L i c e n s e d  P r o d u c t ,  o r  a n y  p a r t  o f  i t ,  s h a l l

b e  t h e  p r o p e r t y  o f  K R I Y A .  P r i o r  t o  m a k i n g  a n y  a d d i t i o n a l  c o p i e s  o r  o t h e r  u s e s  o f  t h e  L i c e n s e d  P r o d u c t  f o r

i n s t r u c t i o n a l  p u r p o s e s .  Y o u  m u s t  c o n t a c t  S i m o n  &  S c h u s t e r  S o f t w a r e  a n d  r e q u e s t  a  c o p y  o f  a  s e p a r a t e  s i t e
l i c e n s i n g  a g r e e m e n t .

5.  Protect ion and Secur i ty
Y o u  a g r e e  n o t  t o  d e l i v e r  o r  o t h e r w i s e  m a k e  a v a i l a b l e  t h e  L i c e n s e d  P r o d u c t  o r  a n y  p a r t  o f  i t ,  i n c l u d i n g  w i t h o u t

l i m i t a t i o n  p r o g r a m  l i s t i n g s ,  o b j e c t  c o d e  a n d  s o u r c e  c o d e ,  t o  a n y  p e r s o n  o t h e r  t h a n  K R I Y A  o r  i t s  e m p l o y e e s .

e x c e p t  f o r  p u r p o s e s  s p e c i f i c a l l y  r e l a t e d  t o  y o u r  u s e  o f  t h e  L i c e n s e d  P r o d u c t ,  w i t h o u t  t h e  p r i o r  w r i t t e n

c o n s e n t  o f  K R I Y A .  Y o u  s h a l l  t a k e  a l l  r e a s o n a b l e  s t e p s  t o  s a f e g u a r d  t h e  L i c e n s e d  P r o d u c t  a n d  t o  e n s u r e  t h a t

n o  u n a u t h o r i z e d  p e r s o n  s h a l l  h a v e  a c c e s s  t o  i t  a n d  t h a t  n o  u n a u t h o r i z e d  c o p y  o f  a n y  p a r t  o f  i t  i n  a n y  f o r m
s h a l l  b e  m a d e .



6 .  L i m i t e d  Wa r r a n t y

I f  Y o u  a r e  t h e  o r i g i n a l  c o n s u m e r  p u r c h a s e r  o f  a  d i s k e t t e  a n d  i t  i s  f o u n d  t o  b e  d e f e c t i v e  i n  m a t e r i a l s  o r

w o r k m a n s h i p  ( w h i c h  s h a l l  n o t  i n c l u d e  p r o b l e m s  r e l a t i n g  t o  t h e  n a t u r e  o r  o p e r a t i o n  o f  t h e  L i c e n s e d  P r o d u c t )

u n d e r  n o r m a l  u s e .  S & S  w i l l  r e p l a c e  i t  f r e e  o f  c h a r g e  ( o r ,  a t  S & S ' s  o p t i o n ,  r e f u n d  y o u r  p u r c h a s e  p r i c e )  w i t h i n

3 0  d a y s  f o l l o w i n g  t h e  d a t e  o f  p u r c h a s e .  F o l l o w i n g  t h e  3 0 - d a y  p e r i o d .  a n d  u p  t o  o n e  y e a r  a t t e r  p u r c h a s e .

S & S  w i l l  r e p l a c e  a n y  s u c h  d e f e c t i v e  d i s k e t t e  u p o n  p a y m e n t  o f  a  $ 5  c h a r g e  ( o r ,  a t  S & S ' s  o p t i o n ,  r e f u n d  y o u r

p u r c h a s e  p r i c e ) ,  p r o v i d e d  t h a t  t h e  L i m i t e d  W a r r a n t y  R e g i s t r a t i o n  C a r d  h a s  b e e n  f i l e d  w i t h i n  3 0  d a y s

f o l l o w i n g  t h e  d a t e  o f  p u r c h a s e .  A n y  r e q u e s t  f o r  r e p l a c e m e n t  o f  a  d e f e c t i v e  d i s k e t t e  m u s t  b e  a c c o m p a n i e d  b y

t h e  o r i g i n a l  d e f e c t i v e  d i s k e t t e  a n d  p r o o f  o f  d a t e  o f  p u r c h a s e  a n d  p u r c h a s e  p r i c e .  S & S  s h a l l  h a v e  n o

o b l i g a t i o n  t o  r e p l a c e  a  d i s k e t t e  ( o r  r e f u n d  y o u r  p u r c h a s e  p r i c e )  b a s e d  o n  c l a i m s  o f  d e f e c t s  i n  t h e  n a t u r e  o r

o p e r a t i o n  o f  t h e  L i c e n s e d  P r o d u c t .

T h e  s o f t w a r e  p r o g r a m  i s  p r ov i d e d  " a s  i s "  w i t h o u t  w a r r a n t y  o f  a ny  k i n d ,  e i t h e r
e x p r e s s e d  o r  i m p l i e d ,  i n c l u d i n g  b u t  n o t  l i m i t e d  t o  t h e  i m p l i e d  w a r r a n t i e s  o f  m e r c h a n t -

a b i l i t y  a n d  f i t n e s s  fo r  a  p a r t i c u l a r  p u r p o s e .  T h e  e n t i r e  r i s k  a s  t o  t h e  q u a l i t y  a n d
p e r f o r m a n c e  o f  t h e  p r o g r a m  i s  w i t h  Y o u .  S h o u l d  t h e  p r o g r a m  p r o v e  d e f e c t i v e ,  Y o u  ( a n d

n o t  K R I YA  o r  S & S )  a s s u m e  t h e  e n t i r e  c o s t  o f  a l l  n e c e s s a r y  s e r v i c i n g ,  r e p a i r  o r
c o r r e c t i o n .

S o m e  s t a t e s  d o  n o t  a l l o w  t h e  e x c l u s i o n  o f  i m p l i e d  w a r r a n t i e s ,  S O  t h e  a b o v e
e x c l u s i o n  m a y  n o t  a p p l y  t o  Y o u .  T h i s  w a r r a n t y  g i v e s  Y o u  s p e c i t i c  l e g a l  r i g h t s ,  a n d  Y o u
m a y  a l s o  h a v e  o t h e r  r i g h t s  w h i c h  v a r y  f r o m  s t a t e  t o  s t a t e .

Ne i the r  KR IYA  nor  S&S  war ran ts  tha t  the  func t ions  con ta ined  i n  the  p rogram w i l l
meet  your  requi rements  or  that  the operat ion of  the program wi l l  be  un inter rupted or
er ror  f ree .  Ne i ther  KRIYA,  S&S nor  anyone e lse  who has  been invo lved in  the  creat ion
o r  p r o d u c t i o n  o f  t h i s  p r o d u c t  s h a l l  b e  l i a b l e  f o r  a n y  d i r e c t ,  i n d i r e c t ,  i n c i d e n t a l ,  s p e c i a l

o r  c o n s e q u e n t i a l  d a m a g e s ,  w h e t h e r  a r i s i n g  o u t  o f  t h e  u s e  o r  i n a b i l i t y  t o  u s e  t h e
product ,  or  any  breach of  a  war ranty,  and S&S sha l l  have no respons ib i l i ty  except  to
r e p l a c e  t h e  d i s k e t t e  p u r s u a n t  t o  t h i s  l i m i t e d  w a r r a n t y  ( o r ,  a t  i t s  o p t i o n ,  p r o v i d e  a  r e f u n d

o f  t h e  p u r c h a s e  p r i c e ) .

N o  s a l e s  p e r s o n n e l  o r  o t h e r  r e p r e s e n t a t i v e  o f  a n y  p a r t y  i n v o l v e d  i n  t h e  d i s t r i b u t i o n  o f  t h e  L i c e n s e d

P r o d u c t  i s  a u t h o r i z e d  b y  K R I Y A  o r  S & S  t o  m a k e  a n y  w a r r a n t i e s  w i t h  r e s p e c t  t o  t h e  d i s k e t t e  o r  t h e  L i c e n s e d

P r o d u c t  b e y o n d  t h o s e  c o n t a i n e d  i n  t h i s  Ag r e e m e n t .  O r a l  s t a t e m e n t s  d o  n o t  c o n s t i t u t e  w a r r a n -

t i e s ,  s h a l l  n o t  b e  r e i i e d  u p o n  b y  Y o u ,  a n d  a r e  n o t  p a r t  o f  t h i s  A g r e e m e n t .  T h e  e n t i r e  a g r e e m e n t  b e t w e e n

K R I Y A ,  S & S  a n d  Y o u  i s  e m b o d i e d  i n  t h i s  A g r e e m e n t .

7.  General
I f  a n y  p r o v i s i o n  o f  t h i s  E n d  U s e r  L i c e n s e  A g r e e m e n t  i s  d e t e r m i n e d  t o  b e  i n v a l i d  u n d e r  a n y  a p p l i c a b l e  s t a t u t e

o r  r u l e  o f  l a w ,  i t  s h a l l  b e  d e e m e d  o m i t t e d  a n d  t h e  r e m a i n i n g  p r o v i s i o n s  s h a l l  c o n t i n u e  i n  f u l l  f o r c e  a n d  e f f e c t .

T h i s  E n d  U s e r  L i c e n s e  A g r e e m e n t  i s  t o  b e  g o v e r n e d  b y  a n d  c o n s t r u e d  i n  a c c o r d a n c e  w i t h  t h e  l a w s  o f  t h e

S t a t e  o f  N e w  Y o r k .

A p p l e  C o m p u t e r,  I n c . ,  m a k e s  n o  w a r r a n t i e s ,  e i t h e r  e x p r e s s  o r  i m p l i e d ,  r e g a r d i n g  t h e  e n c l o s e d
c o m p u t e r  s o f t w a r e  p a c k a g e ,  i t s  m e r c h a n t a b i l i t y,  o r  i t s  f i t n e s s  f o r  a n y  p a r t i c u l a r  p u r p o s e .  T h e

e x c l u s i o n  o f  i m p l i e d  w a r r a n t i e s  i s  n o t  p e r m i t t e d  b y  s o m e  s t a t e s .  T h e  a b o v e  e x c l u s i o n  m a y  n o t
a p p l y  t o  y o u .  T h i s  w a r r a n t y  p r o v i d e s  y o u  w i t h  s p e c i f i c  l e g a l  r i g h t s .  T h e r e  m a y  b e  o t h e r  r i g h t s
t h a t  yo u  m ay  h ave  w h i c h  va r y  f r o m  s t a t e  t o  s t a t e .





E
Typing IF YOU CAN'T TYPE, YOU CAN'T COMPUTE

Tutor II 300,000 PEOPLE LEARNED TOTYPE WITH TYPING TUTOR® III

"The best typing instruction program for personal computing
that I  have seen.'

Erik Sandberg-Diment, The New York Times

" Lo t s  o f  fe a t u r e s  t h a t  m a ke  i t  a s  s i m p l e  fo r  a  b u s i n e s s  exe c u -

U I Y  K R I Y A  S Y S T E M S  I N G

t ive to learn as it does for a child."

Stephen  Wi l l i ams,  Newsday

NOW TYPING TUTOR® IV RAISES THIS
CLASSIC TO A NEW LEVEL OF EXCELLENCE
This  remarkable program automat ical ly  adjusts to your unique abi l i t ies and

progress, creating custom-designed lessons especially for you. Learn at your
own pace as Time Response Monitor ing™ analyzes the resul ts  of  each les-
son  and prac t ice  test .  The program c lear ly  exh ib i ts  your  speed,  accuracy,
strengths, and weaknesses, and graphs your progress along the way.

Now with these dynamic new enhancements:

an un l imi ted  number  of  lessons  us ing  Eng l ish  words  and sentences

use  of  the  fu l l  keyboard ,  inc lud ing  the  numer ic  keypad and the  sh i f t  and
b a c ks p a c e  ke ys

i m p rove d  m e n u s  t h a t  m a ke  p ro g r a m  o p e r a t i o n  e a sy
mult ip le  speed tests  or  custom-made tests  of  your  own
specia l  instructor 's  sect ion for  c lassroom or  corporate t ra in ing

WITH NEW LETTER INVADERS®

Now more exciting than ever, this fascinating arcade-style game has improved

graphics and act ion. I t  features two great ways to play-at your current level
or  us ing the fu l l  keyboard. has Word Ships, Boomlets, two-player competi-
tion, and all-time highest score display.

T y p i n g  T u t o r ,  L e t t e r  I n v a d e r s ,  K r i y a  S y s t e m s ,  a n d  c o l o p h o n  a r e  r e g i s t e r e d  t r a d e m a r k s  o w n e d  b y ,  a n d  l i c e n s e d  f r o m ,  K r i y a

S y s t e m s ,  I n c .  T i m e  R e s p o n s e  M o n i t o r i n g  a n d  T R M  a r e  t r a d e m a r k s  o w n e d  b y ,  a n d  l i c e n s e d  f r o m ,  K r i y a  S y s t e m s ,  I n c .

System Requ i rements
C ove r  p h o t o g r a p h  by  C a r l  F i s c h e r

•  5 1 2 K  M a c i n t o s h  o r  M a c i n t o s h  P l u s IXKRIYA
ISBN 0-671-66705-X

66705

Simon & Schuster  Software
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